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Hello Everyone!

Welcome to, yet again, another edition of the USF PADD. It’s been a long time
coming in getting the PADD back up on its feet, but a lot of creative minds have once
again come together to make this publication possible. | am the player of the character
Havraha cha’AAnikh, and | am currently taking over responsibilities as Editor-In-Chief for this
‘ere fine pooblication. If you’re fans of the previous incarnations of the PADD, then you
needn’t fear, for many of the same elements of the past PADDs are returning in all their
glory. That being said, we have a number of new articles and series planned for the PADD
as well. Therefore, we should waste little time and get on to introducing you to the
contributors and elements we have planned for the publication.

Stay Frosty,

Lieutenant Commander Havraha cha’AAnikh
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Star Trek News

Star Trek — The Prequel AKA Star Trek XI - The Academy Edition

What’s this? A brand new Constitution Class, USS Enterprise picture?

Although we would like to think that this may be the new USS Enterprise, there is still no
official picture that has been sent out or leaked out about our favorite ship. This picture
seems to be made by the same atrtist that made the one below, remember this one?

This picture was developed by Gabriel Koerner, and apparently used to catch the eye of JJ Abrams, and
likely ILM. While the site is still officially under construction, you can at least see the best trailer so far that
came out with the release of Cloverfield. Here’s to hoping for May 2009 to come quickly. In case you need the
link, http://www.startrekmovie.com/. Tell us how you feel; are you anxious for the next movie? Or are you
going to wait for it to come out on cable?



http://www.startrekmovie.com/

THAT'S AWRAP!

Here’s a bit of data from Star Trek Magazine (the UK edition that sold in the US). | thought
it was definitely brow raising. This can be found coming out of its next issue on the 24t of
June. Tell us what you think.

Principal photography on the new Star Trek movie is complete, with the first unit wrapping in March, and the
film has now moved into postproduction. "I feel like this is so unlike what you expect, so unlike the Star Trek
you’ve seen,” J.J. Abrams explains. "At the same time it’s being true to what’s come before, honoring it."

This can be found at http://www.titanmagazines.com/app?service=external/Product&sp=1640

Star Trek Merchandise —

Feel like a Ferengi with a pocket full of latinum and nowhere to spend it. Well read
below, and find out about the licenses that CBS has finally granted to get new Star Trek
product out on the floor.

CBS Announces Over a Dozen New Trek Product Licenses June 10,
2008

by John Tenuto , Filed under: Merchandise, Star Trek (2009 film), Trek Franchise,
http://trekmovie.com/2008/06/10/cbs-announces-over-a-dozen-new-trek-licenses/trackback/

Trek back with Mattel and many more big names

As reported yesterday, CBS Products is at the New York Licensing Expo this week talking up the Trek brand.
Today CBS has officially announced over a dozen new Trek licenses with partners like Mattel, Fortune
Fashions, Pez many more. The licenses cover things from toys, to electronic devices, to clothes, to food, to
bedding, so the next year is shaping up to be a Trek collectors dream.

The new Trek licenses cover a wide variety of areas, here is a quick breakdown.

Lots of new Trek toys and games from Mattel

Mattel, the world’s largest toy company, has licensed the worldwide rights to create numerous branded
products including a line of Star Trek-themed Barbie® Collector dolls; Tyco® R/C flying radio controlled
vehicles; a Scene 1t?® DVD game that includes content from Star Trek television series and movies; and a
20Q Star Trek trivia game. Mattel has had a Trek license before, in the late nineties they made a few toys
including TOS-era themed Barbie and Ken dolls. However, this new license appears much more extensive.

Trek T-Shirts and costumes

Fortune Fashions will introduce a line of “fashion-forward, trend-right tees” featuring iconic characters and
phrases from the Star Trek universe for the U.S. Fortune joins other recent T-shirt licensees Steve & Barry’s
and Junkfood in the U.S. and NTD in Canada. And Rubies is back; the costume maker who had the worldwide
license for Trek costumes for years before letting it lapse now has it again.

Trek candy and cakes.
The CBS release included the official announcement of the Star Trek Pez, which TrekMovie.com previewed


http://www.titanmagazines.com/app?service=external/Product&sp=l640
http://trekmovie.com/2008/06/10/cbs-announces-over-a-dozen-new-trek-licenses/
http://trekmovie.com/category/trek-merchandise/
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http://trekmovie.com/2008/06/10/cbs-announces-over-a-dozen-new-trek-licenses/trackback/

last weekend. In addition, CBS announced DecoPac will be making Trek-themed cake decorating kits for US
and Canada and Les Chocolats VVadeboncoeur will be doing Trek Easter chocolates in Canada. CBS also
announced that Hallmark (who already make Trek ornaments and greeting cards) will now do Trek party
supplies, which should go along great with your Trek cake.

Polar Lights and AMT Models

CBS also announced a new licensing deal with Round Two (for USA and Canada) who are the new owners of
the Polar Lights and AMT brand model kits. So we should expect some new models coming down the road
soon, and in fact a re-issue of the Polar Lights TOS-era Enterprise has already been announced for Fall.

Collectible stamps and key chains.

Two more licenses will come as good news to collectors. IGPC will be providing Trek collective stamps,

which are stamps issued from around the world and resold in collectors packages. Plus Basic Fun will be

making Trek figural key chains (USA & Canada), which are likely to be similar to the new Star Wars key
chains available now at retailers.

But wait, there’s more
Other new Trek licensees announced by CBS:

Dreamlink (US) — USB computer accessories

GIT (Worldwide) — Digital collection of all Star Trek comics published through 2005
Northwest (US & Canada) — Pillows and throws

Armitron/E. Gluck Corporation (US & Canada) — Watches

Star Trek movie helping the big push
Clearly the Summer 2009 Star Trek feature is increasing interest in the Trek brand, allowing for this big
expansion. In the official release CBS Executive Vice President Liz Kalodner noted:

We want to make the brand more accessible to not only those fans of Star Trek, but to all those fans of pop
culture who appreciate the brand for what it represents. With a feature film release set for May 2009, Star Trek
will be introduced to a whole new generation.”

This is big

This list is very exciting for collectors and general fans. While Star Trek certainly has been marketed widely
during the last four decades, it has not been marketed this widely, with this kind of variety, all at the same
time. Secondly, the list (combined with the earlier announcement that Playmates will be doing Toys and
collectibles for the Star Trek feature film) shows that CBS Consumer Products is trying to engage all kinds of
fans. There are products geared to all ages and to women, men, and families. Also, CBS is trying to introduce
Star Trek to other kinds of collectors. Stamp, Barbie, Pez, and radio controlled vehicle collectors are their own
subcultures. These kinds of products are for those brand collectors and Star Trek fans. It is a great way to
introduce Star Trek to a wider audience at retail stores and with these kinds of hobbies. It also means that the
Star Trek film marketing, much like Indiana Jones, will involve both retro Trek and new Trek. For example,
the Indy film toys now are based not only on the newest film, but also the previous features. There will
obviously be plenty of TOS items this year as get closer to the film. Basically, what this all means is that in
2008 and 2009, Star Trek is finally one of the “big guys” of marketing. Many of the items on the list are the
kinds of products you see with Star Wars, and it is great to think that Star Trek has the potential of being in the
same league. Frankly, its about time.

More details to come
There are still more details to be revealed about the specific products from the new licensees, so look for



future “‘Collective’ columns to bring you news and previews of what we can expect in Trek Merchandise over
the next year.

Read the article online at: http://trekmovie.com/2008/06/10/cbs-announces-over-a-dozen-new-trek-licenses/

Conventions -

That’s right Star Trek fan’s its convention season. That time of the year when we dust off
our uniforms, shine up our PIP’s, and set the phasers to stun. Below are a few conventions to
mark your calendars for:

Where: Las Vegas, Nevada - Hilton Las Vegas
When: Wednesday, August 6t to Sunday, August 10, 2008

Who: Okay... there are a ton of them... here we go...
Leonard Nimoy, Scott Bakula, Zachary Quinto, Avery Brooks,
Kate Mulgrew, Brent Spiner, Roberto Orci, Alexander Siddig,
Michael Dorn, Malcolm McDowell, Robert Picardo, Jolene
Blalock, Nicheele, Nichols, Garrett Wang, Connor Trinneer,
Dominic Keating, Anthony Montgomery, Marina Sirtis, Majel Roddenberry, Walter Koenig,
Rene Auberjonois, Tim Russ, Robert D. McNeill, Robin Curtis, Eugene Roddenberry, Nana
Visitor, Armin Shimerman, JG Hertzler, Jeffrey Combs, Carel Struycken, Barbara March,
Ethan Phillips, Nicole deBoer, Salome Jens, Ron Jones, Alice Krige, Sandra Smith, Michael
Forest, Susan Gibney, Suzie Plakson, Max Grodenchik, John deLancie, Denise Crosby,
Jennifer Lien, Manny Coto, Brannon Braga, Gary Lockwood.

What: What what?
Why: Come on its Trek!

For more information please visit:
http://www.creationent.com/cal/stlv.htm?gclid=CNT4jbGb ZMCFSQdagod8SZAXA

A multi-verse show that | heard was really neat
to go to! For more information here is Captain
Lyra Rose on the details.

PN Aug 29-5ept |, 2008
..:'f.f .
Atlanta, Georgia

Where: Atlanta, Georgia (Hilton, Hyatt, Marriott
and Sheraton Hotels)

When: Labor Day Weekend

Who: Bob Picardo, Avery Brooks, Cirroc Lofton, Kate Mulgrew, Walter
Koenig, George Takei, Brad Dourrif

What: Dragon*con


http://trekmovie.com/2008/06/10/cbs-announces-over-a-dozen-new-trek-licenses/
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Why: It is one of the biggest conventions on the east coast!

Special Event: Panel Discussion on Simming and Online Role-Playing

(hosted by USF alumni) The Simming panel is tentatively scheduled for 2:30 p.m. on Friday,
the first day of the convention. Come on out and meet some fellow simmers/USFers!

For more information check out the website at www.dragoncon.org

Star Trek — The €xhibition

Alright, | can tell you already, that | can kick myself for
not heading down to Long Beach and taking in this
exhibit. However, | may just head down to San Diego
and take in the sites. Hey whats better than seeing
Shamu and Star Trek all in one weekend? Here’s more
information from the website itself.

STAR TREK THE EXHIBITION, the multi —city touring exhibitions containing the world’s most
comprehensive collection of authentic Star Trek ships, sets, costumes and props from all 5 series and 10 films
over the last 40+ years, makes its North American official US Launch on June 21st for a limited engagement
at the San Diego Air & Space Museum located in Balboa Park in San Diego, Calif.

This unprecedented event will give the public the opportunity to step inside the Star Trek world and become
active participants in the legacy that has captured the imagination of generations: From the chance to sit on a
spaceship bridge from the Original TV series to traveling through space on motion simulators, STAR TREK
THE EXHIBITION offers the whole family the opportunity to be fully immersed in the action. Plus, the
exhibition features the world’s largest collection of authentic Star Trek ships, sets, costumes and props from
all 5 TV series and 10 films over the last 40 years.

Tickets will go on sale opening day June 21st. Special prices available for groups of 15 or more. Call 1-800-
840-1157 for more information. The show will be open 7 days a week, Mon-Thu & Sunday 10AM - 5:30PM
and 10AM - 10PM on Friday and Saturday.

Ticket Information

Online tickets are on sale now! Click here to buy tickets now.

General Tickets


http://www.dragoncon.org/
http://www.museumtix.com/venue/program.asp?vid=746&pid=1912114

e Adults (12+) - $24.00

e Youth (3-11) - $16.00

e Active Duty Military with ID - $15.00

« Senior/Student/Retired Military - $22.00

For more information visit the museums website at http://www.aerospacemuseum.org/startrek/museum.html

USF Movie Review

With Rear Admiral John Styre, Fleet Captain Rylan J Hirsch, and Lieutenant
Commander Havraha cha’AAnikh

Good Morning, Afternoon or Evening movie fans! A few
of the editors and contributors in the USF are avid movie
fans, and it suddenly dawned on us that reviewing films
would make for a great segment. We’ve come together
to review some of this summer blockbusters, and of course
the summer has just begun but we’ll be bringing you
reviews of the movies that we’ve seen. If you’d like to
contribute please send us an email at
USFPADD@gmail.com with “Movie Review” in the subject.
Lights! Sound! Action!

Havraha: So. GET SMART. GO.

Havraha: Smarty pants.

CommodoreStyre: Well, | thought it was hilarious.

CommodoreStyre: The humor was in the same vein as the old show, built around wit and
slapstick... | was afraid it was going to be lowbrow or crude but it
wasn't at all.

Havraha: Even with half naked Agent 99s?

FItCptRJHirsch: The only part that she was completely sexy
was when she was dancing in her evening gown.

Havraha: Now | didn't see the film, but from the trailer | saw it
looked like 99 had a bit of an attitude problem. Which | don't
remember her having in the television series.

CommodoreStyre: Well, | know next to nothing about the show.
CommodoreStyre: But, since it's what, 40 years later, the movie
shouldn't really be rooted in the old show to begin with.
FItCptRJHirsch: She was tougher in this version, not the side
kick that got things right, but more of a leading lady that knew
her stuff. She was very much a woman for this century instead of
the step to the side age of the 60's.

Havraha: Hmm.

Havraha: So the casting was well done?
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FItCptRJIHirsch: Yeah, I'm not much on the show either... | know | didn't enjoy it, but | enjoyed
this movie.

CommodoreStyre: Casting was excellent.

CommodoreStyre: Dwayne Johnson, who apparently dropped "the Rock" appellation, is
surprisingly natural at comedy.

FItCptRJIHirsch: I'm not a huge Steve Carroll fan, but he did okay. | love seeing Anne Hathaway,
she's definately showing her ability to play different rolls well.

Havraha: Anne Hathaway is hot, but it’s always a kind of weird hot to me. | first saw her in the
Princess Diaries, so she'll always come across to me as a geek.

Havraha: Which she may not be, for all | know.

CommodoreStyre: | enjoyed Terrence Stamp as the villain, too, though | spent most of the movie
thinking he was Malcolm McDowell. Which | suppose is a compliment.

Havraha: I laugh every time | seem Malcolm McDowell in anything. And | honestly don't know
why. | think it’s because he's a character, that same creepy evil character over and over and over
again.

Havraha: So much so that instead of saying "Oh hey, there's the
villain of the show!" | go "Oh look, its a cameo appearance by
Malcom McDowell!"

Havraha: Of course, getting off topic. So ... thumbs up?
Thumbs down?

FItCptRJIHirsch: Thumbs up, but see it at Matinee prices.
Havraha: Ewww. So it was kind of stupid in the same vein?
CommodoreStyre: Thumbs up. It's hilarious -- | was laughing
throughout -- and it's got a heart without ever coming across as
cheesy. That's incredibly rare in current comedy.

Havraha: Would people who like INTELLIGENT comedies like this movie?

CommodoreStyre: What's an intelligent comedy?

FItCptRJIHirsch: probably not, this is in my opinion definitely one where you leave the last
remaining brain cell at home to relax.

Havraha: Intelligent comedies have wit. Non-intelligent comedies are Scary Movie, Dude
Where's My Car, the like.

FItCptRJHirsch: oh see | think of inteligent comedy like
that movie the Tennenbaums

CommodoreStyre: Well, this is superior to those.
FItCptRJHirsch: Which | really didn't like
CommodoreStyre: Someone who dismisses this version of
Get Smart as "below them" probably has an arrogance

problem

FItCptRJIHirsch: yes, this is superior to Dude Where's My
Car.

Havraha: | do believe | lost brain cells after Dude Where's
My Car.

CommodoreStyre: It's surprisingly mature, even if some of
the jokes revolve around walking into walls.

FItCptRJHirsch: The kids will still like it though, and
anyone who wants to see Steve Carrols posterior.

Havraha: Allright. Iron Man? You guys see that one?
CommodoreStyre: Nope.

FItCptRJHirsch: Saw it

Havraha: Alright Hirsch. Your thoughts?

FItCptRJIHirsch: Well first of all I'm not a comic book fan...

so | really don’t know back story or anything of that nature.




FItCptRJHirsch: However, | really had my doubts about this one because of Robert Downey Jr.
Havraha: Aww what do you have against Robert?

FItCptRJIHirsch: | still see him as the actor that's drugged out lying on the floor of Less than Zero
Havraha: Yeah but that’s the Hollywood gold standard these days.

FItCptRJHirsch: And haven't been impressed since then... never really was even when he was
in Weird Science, one of my all time favorite movies.

CommodoreStyre: I've loved his recent stuff.

FItCptRJHirsch: | will give him kudos... he did well.

CommodoreStyre: greatin Good Night & Good Luck, Scanner Darkly, Zodiac

Havraha: But you enjoyed Iron Man?

FItCptRJHirsch: Do | see him continuing to play Stark... no. But | think the first movie was good
and action packed.

FItCptRJIHirsch: the CGI was very hot

Havraha: | felt ron Man was pretty exciting but as far as drama goes, it was a rather weak
movie.

Havraha: The entertainment value was almost solely supported, to me, by the kind of "wow
that's awesome" feeling that overwhelmed you throughout the film

Havraha: even his charm as Stark had an "awesome" flair to it. But that’s just because its new.
Havraha: | think if they continue along the same lines for ron Man 2, it'll be less successful.
FItCptRJHirsch: What did you think of Paltrow?

Havraha: Kind of boring, really. | mean her character was nothing

more than a damsel in distress.

Havraha: Especcially at the end.

FItCptRJHirsch: Yeah... she wasn't right for that role, | could

probably have seen other actress do it and have been better.

Havraha: | agree. Thumbs up but | wouldn't bother buying it on

DVD.

FItCptRJIHirsch: Thumbs up... definately buy it if you're the DC

comics fan... but otherwise wait till its 5.99

CommodoreStyre: Marvel

FItCptRJHirsch: which ever LOL

FItCptRJHirsch: | told ya | dont know anything about comics.

— " ' @l Havraha: Now, "I" saw The Incredible Hulk,

which | recommend people see. It wasn't

technically INCREDIBLE, but more so adequate.

The eerie thing about Hulk was that it combined
the last movie, the comic, and the TV show

 perfectly.

Havraha: So it definitely FELT like Hulk, but at

the same time that was its problem.

Havraha: It didn't really feel NEW, or amazing

that often. It felt like we'd kind of seen it before,

S0 ... as a reboot, it just didn't deliver. But it was

definitely good.

FItCptRJHirsch: See never a big fan of the
series

FItCptRJHirsch: nor of the movie...

Havraha: Some of the best parts to it are the

parts that hadn't really been explored before in a
film -- like Banner's need to stay calm in everyday
situations, like people shoving him on the street
and stuff.
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FItCptRJHirsch: That's why | didn't bother with this one

FItCptRJIHirsch: See that there doesn't do it for me
FItCptRJIHirsch: because the original series didn't have it like that
Havraha: Yeah but | think that's an improvement.
FItCptRJIHirsch: he turned into hulk when the adrenaline really went up not from a simple
thump on the shoulder.
Havraha: But the trick is he's supposed to have anger management issues. And that actually
helps the drama, because now you have an everyday struggle, really.
FItCptRJIHirsch: was that part of the comics?
Havraha: If you think about it, the Hulk is the Hercules story reborn.
Havraha: A man of incomprehensible strength, who goes into fits of rage and murders people
without remembering what happened before. The drama is improved the more likely he is to
change.
Havraha: Oh, | can't recall
FItCptRJIHirsch: LOL, | dont know if I'd go with you there... but thumbs up or thumbs down... and
| think | know this one.
Havraha: Also, its worth to note that ... oh ... whats his name ... the star of the
movie... he's probably the best Banner so far, in my opinion.
FItCptRJIHirsch: Edward Norton
Havraha: NORTON, right.
Havraha: He has a very laid back and relaxed attitude to how he talks, which

REALLY helps bring out the "one side of the coin is calm, the other side is insane"
quality to the character.

Havraha: I'd have to give the Hulk a thumbs up, but it’s just because of all the
fine details they got right. The details are perfect, but the overall story just didn't
feel very new to me.

Havraha: In fact, it feels like | only watched half of the movie, and they're
saving more for later
Havraha: Which is evident with the twist at the end of the film.
Havraha: If you don't know what I'm talking about, | probably
shouldn't spoil it for you.
FItCptRJHirsch: We'll let ya keep the spoiler on that one.
Havraha: Right.
Havraha: Well, what other films have we seen?
Havraha: I've seen the Strangers.
FItCptRJHirsch: Well after Indy, | took my mom to see Sex In
The City.
Havraha: Let's touch on Indy.
Havraha: Hirsch, your thoughts?
FItCptRJHirsch: Okay... I'm going to label this the best

blockbuster summer opening in a long time. | thought the movie
was great. The ending could have used a little more umph... but
the beginning, the middle, all traditional Indy. | think Lucas

FItCptRJHirsch: just got his hands on it at the end and
Steven said okay.
Havraha: | have to say it was probably one of the biggest

disappointments in cinematic history, to me. It was quite clear
that George Lucas got his hands on the thing and couldn't be controlled at all.

Havraha: I mean come on. CGI gophers?
Havraha: Really?
FItCptRJHirsch: Prarie Dogs

11



Havraha: You really have to understand Lucas' likes and dislikes to realize how much influence
he had on this film -- he likes James Dean characters, if that's not evident with Anakin Skywalker.

Havraha: And what do we have in this film? Mutt Wiliams, James Dean in disguise.
FItCptRJHirsch: Well 1950's that was the sock hop era... the era of the James Deans, and
Natalie Woodes.

FItCptRJIHirsch: He did make American Graffitti after all.

Havraha: We also have Mutt Williams swinging through the trees on a vine Tarzan style to catch
up with a speeding car miles ahead of him.

Havraha: We have man-eating CGI ants that eat people alive in a matter of seconds, ala the

scarabs from The Mummy films.

CommodoreStyre: Kind of unsurprising then that American Graffiti is arguably his best film, you
know?

CommodoreStyre: re: 1950s and James Dean

FItCptRJHirsch: yeah, but he lost it in American Graffitti 2
FItCptRJHirsch: but I digress.
Havraha: Star Wars was a fine film as well, but the trick is he had friends to re-write his scripts

back then. Now, he has no one to curb the cheesiness that prevailed throughout the new Star Wars
trilogy and this film.

FItCptRJIHirsch: Okay... CGl ants... | thought were cool... that ala face melting while looking at
the insides of the Ark of the Covenant.

Havraha: He lost the spirit of Indiana Jones, in my mind.

Havraha: Yes but the face melting was a supernatural thing. Theses ants are supposed to exist
in real life ... but they don't. Nothing comes close to them.

Havraha: It just got insulting to one’s intelligence.

Havraha: Now, i DID like the villain.

FItCptRJIHirsch: See and that's where you went wrong. This wasn't about intelligence; it was
about getting out of the hot sun, having a popcorn and soda in your hand on a summer’s day
FItCptRJHirsch: and enjoying an American classic.

Havraha: She was very iconic, iconic enough to match Indiana himself, with

that outfit and accent. But it just didn't carry over.

Havraha: Nah but the SPIRIT of Indiana Jones is more than that though. Raiders and the Last
Crusade both had this very realistic feeling to them,

Havraha: an adventure feeling with a very vulnerable hero as he journeyed on the edges
between the natural and the supernatural, for spiritual growth.

Havraha: This reduced Indiana to a cheesy B movie.

FItCptRJHirsch: Actually | didn't like the Last Crusade.

Havraha: | have to say ... villain was good; opening scene was awesome ... downhill from there.

Especially the twist towards the end.

Havraha: Oh WHAT'S WRONG WITH YOU!
Havraha: Fightin words there son.

FItCptRJIHirsch: it's true... sorry you don’t make Sir
Sean Connery into a bumbling fool.

Havraha: I'd think Ford had gotten just too old as
well. If they could have gotten the movie made 5
years ago .... eh, maybe. But now he just kind of
looked frail and saggy. It'd be like bringing Sean
Connery back for one more Bond film. —
Havraha: Overall ... Indiana Jones and the
Kingdom of the Crystal Skull ....

thumbs down.

Havraha: If you can, burn this one out of your memory with alcohol or
something.

-~
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FItCptRJIHirsch: See | think he did great for the age that he's at. He still fit into his same Indy
pants according to movie sources. | mean come on. Yes, he's old, yes this should be the last one
unless they remake it and not have Shia LeBouf

FItCptRJIHirsch: be Indy. He did well... but not that well.

CommodoreStyre: Don't they still have an option for a 5th movie?

FItCptRJHirsch: I'm going for Thumbs Up and would pay full night time price to see.
FItCptRJIHirsch: yeabh... let’s not go there.

Havraha: I'd kill myself if another was ever made.

Havraha: Alright, well | think that about does it for movies in this issue. You guys have any movies
you're looking forward too?

FItCptRJHirsch: Definately seeing Wall-E

CommodoreStyre: The Dark Knight.

FItCptRJIHirsch: love pixar

CommodoreStyre: And the new X-Files movie.

FItCptRJIHirsch: X-Files... that sounds promising

CommodoreStyre: And Hellboy 2.
CommodoreStyre: Might actually have some *good* summer blockbusters this year.

Havraha: Wall-E, The Dark Knight for sure ... might check out Hancock ... and I'll also add Star
Wars: The Clone Warrs to that. It may be horrible, but | have to see it anyway.
FItCptRJHirsch: Hancock... yeah going to see that one... not sure about it though. Star Wars... |

mean come on it better damn well be good

Thanks for reading! Check back for more USF Movie Reviews in the next USF PADD!
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Live from Sector 0393 in SaturNn’'s Rimgs

~~LIVE FROM SECTOR 039 AT SATURNS RINGS YOUR FAVORITE
COLUMINST OF THIS CENTURY AND BEYOND.... HERE'S LARIA!

Laria Moonmoth: :: Laria rushesin :: Have | got a story for you...
you'll never believe this one...

Rico Juan Lobos Mendosa Novas: Ai, do tell, do tell.

Laria Moonmoth: | couldn't believe it myself and | saw it with my
own eyes. While hallucinating, a mere Lieutenant dared to tell
Admiral Mason that HE was the new CO of the Oddy. Can you
believe it? Someone trying to take the Oddy from Admiral
Mason? That would be like taking the Enterprise away from Kirk or Picard. It just doesn't happen.
Rico Juan Lobos Mendosa Novas: NO. Did she throw him out the airlock?

Laria Moonmoth:  No... she didn't airlock the poor Lt. He was on a planet surface, supposed to be
looking for some lost archeologists. She couldn't even get to him to strangle the poor guy because
then she would risk possible exposure to whatever was causing the hallucinating problems to begin
with. Know what's even funnier....

Rico Juan Lobos Mendosa Novas: Hmm, well I've heard of cabin fever but never of Away Team
fever... maybe they should send him to Starfleet medical and do some experiments... no? Wha’ mi
mui caliente friend?

Laria Moonmoth: This Lt didn't just make himself a captain...he made himself a COMMODORE. And
he said he wasn't the one doing it...it was Admiral James T. Kirk who was promoting him.

Rico Juan Lobos Mendosa Novas: Que? Isn't he dead? Si, | know my momma says she talks to our
ancestors, but she's a little loopy in the head. One too many tequila bottles | think.

Laria Moonmoth: Well...in this time line...yes. But the Oddy isn't running with current time
continuum. They got tossed back about 80 years ago...or so the rumor has it. And Admiral Kirk was
very much alive then. Only he was nowhere near where he Oddy was...he was at peace talks half
a galaxy away.

Rico Juan Lobos Mendosa Novas: Hmm... well | think an Admiral rank is like the Royal Flush of
poker... its beats a Full House or a Commodore ranking. Definitely sounds like something we'll have
to keep our eye on.

Laria Moonmoth: | agree. :: Looking at her new partner in crime:: So...what

have you got for me? | can tell you have something.....

Rico Juan Lobos Mendosa Novas: Ai, mi friend... | got news for you... Nigala has bug issues

Laria Moonmoth: No way... do tell. :: Bouncing the edge of her chair::

Rico Juan Lobos Mendosa Novas: Si, si... | didn't think that could happen on the boarders of the
beta and Delta quads, but tis true.

Laria Moonmoth: Dish the dirt... what's the deal? The exterminator forget to pay a visit?

Rico Juan Lobos Mendosa Novas: Well, | was scanning the sector and ran across their data file...
apparently they were rescuing a ship... and it had one sole inhabitant. A Bug, but not just any bug A
BIG BUG!

Laria Moonmoth: :Eyes popping:: How big?

Rico Juan Lobos Mendosa Novas: You know, like the ones in Florida... | think they are cousins... si...
anyway

Laria Moonmoth: :Laughing and motioning for him to continue::

Rico Juan Lobos Mendosa Novas: Jefe Hirsch said to beam it on over, and they did. Nearly ate
the EMH. Si Si. It got a new ensign so nervous that she sprayed the owner of a restaurant with Raid
right in the face. You know... | didn't think we used Raid anymore in this century...
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Laria Moonmoth: :: Jaw dropping :: Oh boy....I thought pesticides were illegal because of the
harm they cause the environment. But...that isn't the question burning in my mind...what happened
to the bug? Did someone squash it?

Rico Juan Lobos Mendosa Novas: No... so it’s Ginormous and is still in sickbay. It’s apparently
carrying with it, its planet in a little tiny whiney box.

Laria Moonmoth: Ewwww....it's still alive?

Rico Juan Lobos Mendosa Novas: Si... it’s intelligent. How would you like that crawling up your
leg?

Laria Moonmoth: :: Shudders to think of an intelligent bug :: | don't think

| could be blamed for killing it. Sorry, but | don't do bugs, well, not the kind that crawl anyway.
Hehehehe.

Rico Juan Lobos Mendosa Novas: Little miss muffet would definitely not be sitting on her tuffet if
some Arana came up to her and said "hi". Si... so rumor has it Preservers are the reason that this
Arana was moving at warp speed, and seeking out the Federation specifically.

Laria Moonmoth: It was looking for us? :: Makes a motion that is similar to someone brushing a bug
off of their arm:: Whatever for?

Rico Juan Lobos Mendosa Novas: | don’t know mi amiga... | definitely think there is more in store
that we need to watch out for.

Laria Moonmoth: | agree. Well, my hot Latino partner...we have our stories for now. :: Shivering
deliciously:: Shall we wrap up this broadcast and head out to gather more? You hesitate...is this
because you have more to tell me?

Rico Juan Lobos Mendosa Novas: Well... | did stumble across the Aggie's data stream...

Laria Moonmoth: :: Grins and rubs her hands together:: Oh? What's happening on the Aggie?
Rico Juan Lobos Mendosa Novas: It was all alone, no others ones with it... but from what |
gathered the animoso crew of the Aggie is planet side... or at least one of the security/tacitical
officers and the XO. And they put herin a dress! And no, its not Vera Wang sounds more like 19th
century Sears and Robuk.

Laria Moonmoth: They put the XO of the Aggie in a Dress? ::sounds incredulous:: How did they
manage that one?

Rico Juan Lobos Mendosa Novas: No, the Security officer!

Laria Moonmoth: Security officer? No way...| thought they all came with a

no dress policy.

Rico Juan Lobos Mendosa Novas: Si, they must have drugged her. But they are looking for
crystals... not sure if it’s Dilithium or diamond.

Laria Moonmoth: Big time. | wonder what they used. Maybe we could get our hands on it and
give it to a couple of the CO's | know. Wouldn't Killian look good in a pink evening gown? And
Ahrele in something swanky and red? How about Mason in something off the shoulder and in
black? Or wait....Eliz in sequins and white?

Rico Juan Lobos Mendosa Novas: Ai, now you’ve just gone too far, Eliz in sequins? Mason | can see
with the classic black off the shoulder. Did you know Ahrele is preggers, si, with baby number three!
Laria Moonmoth: Baby number three? How does she manage?

Rico Juan Lobos Mendosa Novas: Dunno, but | think we need to look that one up. Her husband
must be mui caliente.

Laria Moonmoth: At the very least. And you can be sure we will keep track of Ahrele's current
condition. And confirm the hotness of her hubby.

Rico Juan Lobos Mendosa Novas: That's all for now mi amigo's and amiga's... I'm Rico Juan Lobos
Mendoza Novas and this is

Laria Moonmoth: Laria Moonmoth

Rico Juan Lobos Mendosa Novas: saying you'll never know where we'll be, but watch out,
because we're watching you.

Laria Moonmoth: And we are live from Sector 039, Saturn's Rings.

Rico Juan Lobos Mendosa Novas: Buenos Noche!
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TEMPORAL LEAP
Innovative Education of the 29th Century

presents

"A Covert Look at 24" Century Technology”

by Wilhelmina Sternenschnuppe

Greetings! | am Wilhelmina Sternenschnuppe (pronounced Vill-hell-mean-ah Shtair-nun-
shnoop-puh). You may know me as Doctor Mini from my educational series Temporal Mechanics
and You, produced by the Federation Public Education Agency.

As a public entity interested in bringing the best to all Federation citizens, PEA has always
taken the initiative to explore innovative ways of helping our viewers learn about various subjects.
Once again, we are at the leading edge of such exploration. In compliance with the Temporal Prime
Directive and all other necessary safeguards to the timeline, we have developed a new program and
subsequent magazine article series that are sure to quench your thirst for knowledge.

| am proud to present to you our new series, TEMPORAL LEAP — A Covert Look at 24"
Century Technology, a history program that will look at the inventive minds of the past in a brand
new way. As your host, | will lead you into the past with the use of the latest in temporal technology,
visiting with some of the most intelligent people of the 24™ Century and discovering their inventions
and designs with THEIR help. No, not doctors at museums or professors at laboratories, but those
tried and tested in the field of space exploration, the explorers of the last frontier... everyday
Starfleet officers!

Part I - Falco James Fogarty

To begin our exciting journey, we will visit with one of the most controversial designers of his
time - Falco Fogarty. Join me as we travel back more than five hundred years to his secret design
lab on the USS Lexington-C. At this time, he was serving as Chief of Security with the rank of
Lieutenant.

16



After a slightly bumpy initial introduction, Lieutenant Fogarty is willing to commence with the
interview, though he requires a bit further prove that | am indeed from the future.

Wilhelmina Sternenschnuppe: You may call me Dr. Mini, if you wish. I'm visiting from the 29th
century to give our viewers a close and personal look at the inventions of the 24th century. | have
made a temporal leap in the hope you would let me interview you about your innovative starship
designs.

Falco Fogarty: Hmm, 29th century, eeh. Why are you interested in 24th century designs? They're
way outdated to you.

Dr. Mini: It's a history program on the Public Education Channel. A new and improved way of
acquainting people of all ages with the intelligent minds of the past.

Falco: Not good enough. How do | know you're even from the 29th century?
Dr. Mini: Well... How would you like me to prove it?
Falco: What's the main ship used by the Federation in the 25th century to battle the Borg?

Dr. Mini: Elementary, my dear Lieutenant. That would be the Crusader Class... which YOU
designed.

Falco: Hmm, either you are from the future or you're from Arcane Station, which... | know you're
not. For now, I'll believe you. - So what is it you're wanting to know exactly?

Dr. Mini: My main interest is how you came up with your somewhat unusual designs. There isn't
much information in the history books about how you actually developed some of your interesting
ideas. Would you mind showing us?

Falco: Which design in specific?

Dr. Mini: Why don't we start with the Crusader Class, since we've already mentioned it, and it
played a crucial role in the Federation's defense against the Borg.

Falco: Ok, simple. It just came to me that we needed a better battleship in the fleet. Something
that could do massive damage, like a fist punching through the enemy lines, and be capable of
being repaired on the spot, if needed. And | didn't think the Sovereign was good enough.

Dr. Mini: So, how did you develop the idea further and end up with the Crusader Class vessel?
Falco: Hmm, where to start... Alright... | started with taking the specs OFF a Sovereign Class and
transformed it. Made it shorter but bulkier. Added Disruptor turrets, another warp core, more
torpedo bays and phaser banks. Really... a long list of what | did.

Dr. Mini: | see. It certainly proved to be a power to be reckoned with. However, the Crusader has a

rather unique saucer section shape, which has evoked much discussion and speculation between
experts. What were your thoughts on it, when you designed it?
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Falco: | wanted more room for turrets and the sensor cloak panels. Plus, it gives it the look of a
spear.

Dr. Mini: Interesting. - Some people feel you tended to put aesthetics over functionality. How
would you respond to such opinions?

Falco: Untrue, the fact is the ship could take a Borg Cube on almost single handedly. No other
Federation vessel can do that without having some sort of technological advantage. But... it is true
| wanted it to look nice, otherwise it's just sloppy work, but | made sure to keep the balance between
the two uneven. The ship has more in its technology than it has in looks.

=

essS
Sovereign-Class Crusader-Class

Dr. Mini: How about other ship designs? You didn't just modify already existing layouts, did you?
What are other methods you used in developing vessels?

Falco: Multiple. You'll laugh but...

At this, Lieutenant Fogarty pulls out a large polymer box from a compartment by his desk that
is filled with multi-colored blocks in all shapes and sizes.
Falco: | used these for some. They call them.... Legos.
Dr. Mini: Aren't those children's toys from... the late 20th century?
Falco: AND the most ingenious building parts ever. Fred recommended for me to use them,
thought I'd find them interesting, and | have. You can make anything you want with these and then
sketch it down and turn it into an actual schematic on a console.

This is a very interesting revelation about his brother, Fred Fogarty. | think we all know why...

though, if you are not familiar with Fred Fogarty's life story, you should check out the documentary
series Back To The Future.

Dr. Mini: So, Falco... if | may call you that. Would you mind showing us a model you've put
together with these building blocks that actually became a new ship design?
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Falco: There is one | personally like most. You should recognize this somewhat. And forgive me
for the many colors, but the replicator was confused on what to color them.

Here, Falco produces a small model from another compartment.

Dr. Mini: It reminds me of the Clemens Class... It's one of your recent designs, isn't it?
Falco: Yup, and one of my best, if | do say so.

As | probe a little bit about the naming of the ship, Falco informs me that he has chosen the
name to show Professor Clemens how much of a mentor he had been to him.
Dr. Mini: Anyways... so, what objective did you have with this particular design?
Falco: Sleek, small, maneuverable, undetectable, and just plain awesome. | wanted a ship that
looked really smooth, cause all the others have nacelles that stick out and stuff, and so | designed

this one to have nacelles that folded in and fit with the rest of the ship when it's not traveling at warp.

Dr. Mini: Very ingenious. | can tell you this much, both of these designs have furthered space
exploration and defense of the Federation greatly.

Clemens-Class
Stealth/iReconnaissance vessel

Dr. Mini: | have to admit | came here because I'm curious about one vessel in particular. One of
my personal favorites, and one that had its origin obscured for all these years. The Raven. I've
always felt it was your most cutting edge design. Would you reveal to us how you got the idea?

Falco: Funny for you to say that. Does this look familiar?
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At this point, Falco retrieves a small, black and gray object from an adjacent room and puts it
down on the console. To my utter surprise, it turns out to be a plain razor.

Dr. Mini: Are you kidding me? You got the idea from a razor?!

Falco: Yup, saw it one day and thought it looked a little like a ship. So, | took the front of it and
replaced it with a pair of nacelles. This isn't the only thing I've taken design ideas from you know.
Telephones from the 20th century, old games from then, and much more. But I've developed the
Raven a lot further from this, as you must know.

Dr. Mini: Oh, yes. I'm very familiar with the ship. Would you mind showing us the process you
went through in getting the finished product?

Falco now brings up a series of four images on the console screen that document his thought
process and the actually steps he took in developing the Raven.

Falco: Well... 1) here we got an image of the razor, then 2) | took the razor and sketched the back
of it and replaced the front with some nacelles then flipped it around. 3) I put it into the console and
outlined the drawing, and finally 4) colored it, then fitted the weapons I'd have and changed the
shape to work with it. And I'm not quite on the finished page yet, I'm still thinking of a smaller
redesign.

Dr. Mini: | won't tell you how it eventually turns out, but be assured it is a highly sought after small
craft that lasts long into the future.

Dr. Mini: Well, Falco, | want to express my thanks to you once more for leading us into the world of
designs that your mind creates. It was rather enlightening. .... Very nice to meet you, Lieutenant.
Keep up the good work.

Falco: Well, it was nice to meet you, too. And, by the way, now I'm sure you're from the future.
Only someone from the future would know about the Clemens and Raven.
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With that, our interview came to a conclusion. Of course, with the assistance of the Starfleet
Department of Temporal Mechanics, | safely blocked the event from Falco's consciousness. Don't
worry! The adjustment of his memory will in no way compromise Falco's brilliant actions years later
as Commander of the crack squad of fighters that... well, you know that story already.

Be sure to look up a full-length holorecording of this interview in the Federation Public
Education Agency database, serial number 7854449-001, next time you search the Federation
Holonet. It contains even more interesting information that was not able to be included in this article
due to space.

CHECK OUT MY NEXT ARTICLE about the interview with Cameron Sanantonio, who at the
time of my visit is a Lieutenant Commander and the Acting XO of the USS Lexington-C.

If you would like to see an interview with a particular inventor or designer in line with this program, please submit your
suggestions to usfpadd@gmail.com, subject: “Temporal Leap Interview Request”. USF PADD staff will print the
request on a plastic flimsy and bury it in a specially designed capsule under the rosebushes outside the PADD's main
building, where it will be dug up by PEA staff 500 years later. Please be advised that not all requests may be recovered
and acted upon.

All images in this article copyright © Falco Fogarty, 2008
Text copyright © PEA, 2892
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Original Story:

"Who Waonts to Rule the Alphoe Quadrant?”
By Ensign Joson Ro

Editor’s Note: Ensign Ro was instrumental in jump starting the
PADD, intent on getting our publication up and on its feet.
He was so enthusiastic about the PADD that | could barely
find a way to curb his enthusiasm and keep him from
sending the PADD out immediately! That being said I’'m
extremely delighted to have the privilege of finally getting
some of Ro’s great writing into the PADD where it belongs.

This will certainly be an interesting read, as its format is laid
out much like a screenplay — there’s an incredible focus on
dialogue, but enough detail to the surroundings to help spur
the imagination. If you’re a fan of “what-if” scenarios,
especially those related to Star Trek, this one can’t be
missed.

Who Wants To Rule The Alpha Quadrant?

A product of boredom... Please read, enjoy, comment, or even add

fo It...
{we open in Quark's Bar, where the middle of REESES: Hello! Welcome to Who Wants to be a
the floor has been cleared and a couple of Millionaire! I'm your host, Reeses - {shuts up as
chairs have been set up, just like on that old a production assistant runs up and whispers
Earth game show, "Who Wants to be a something in his ear} Oh, really? Are you sure?
Millionaire?" Also the lights are all blue and {turns back to the audience, wearing a huge
purple and pretty, just like on the game show. fake grin} Excuse me, folks, | mean to say,
Spectators fill the upper level of the bar. The Welcome to Who Wants to Rule the Alpha
lower level is surrounded by prospective Quadrant! I'm your host, Reeses Killben! {loses
contestants, but they are in darkness, so we his grin as he spots some of the scarier-looking
can't see who they are just yet. Thus far, the aliens in the crowd} And | really don't think I'm
contestant's chair is empty. As the lights go up, being paid enough. {looks off-camera,
REESES KILLBEN walks to the middle of the bar presumably at a producer} Are you sure Alec
and addresses the crowd both in the bar and Strebek didn't want to do this? No? Well, he
those standing outside the doors. always was a snob. {clears his throat and tries



to regain his smile} Anyway, welcome to the
show! Now -

{REESES suddenly falls flat on his face as a
phaser blast catches him in the back of the
head. A medical team quickly drags him off
to the infirmary (or, more likely, the morgue) as
ODO walks out to the middle of the bar and
glares at the audience.}

ODO: All right, which one of you did that?
{nobody admits guilt, but several giggles
come from a group of Andorians in the back.
ODO sends one last glare around the room.}
I'l be keeping an eye on you. In the
meantime, we need a new host.

{MARYDIP VEEROVER bounces up from behind
the bar and runs over to the host's chair.}

MARYDIP: I'm here! Hi, I'm Marydip Veerover,
your new host! Welcome to Who Wants to
Rule the Alpha Quadrant! Our first contestant -

{another phaser blast. This time, MARYDIP is
vaporized. ODO frowns at the audience as a
group of Jem'Hadar begin cheering.}

ODO: | don't find this amusing. How are we
going to resolve this struggle for the Alpha
Quadrant if you degenerates keep killing the
hosts?! Quark, get up here. You're our new
host.

QUARK: What?! No way! You think | have a
death wish? Absolutely not. And that's my final
answer.

ODO: Well, Mr. Killben did mention somebody
named Kitty Lee . . .

{suddenly somebody runs past ODO, jumps
into the host's chair, and activates a force-
field around the chair. When this person turns
to the crowd, we see that it is none other than
... BONNY OZMONT! The crowd boos and
several large, heavy, and potentially deadly
objects begin striking the force-field, but
BONNY grins through it all.}

BONNY: {waving to crowd} Hiya! I'll| host the
show! That would be super-cool!
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ODO: {rolls his eyes} If you insist.

BONNY: {aims a huge blinding grin at the
camera} Well, folks, it seems we've taken so
long picking a host that it's time for our first
commercial break! But stick around to see
who will take control of the whole Alpha
Quadrant when we come back! Yeah! It's
gonna be great! {winks and gives two thumbs-
up signs as the picture fades to black.}

{when we return from commercial, we see
that there are now three contestant chairs
instead of just one, and furthermore, DAMAR,
DUKAT, and GARAK are sitting in them. BONNY
grins his slightly maniacal grin at the camera
and ignores the phaser blasts and sharp
objects bouncing off his force-field.}

BONNY: Hey, there! Welcome back! As you all
know, this is Who Wants to Rule the Alpha
Quadrant! The object of the game is to
ultimately decide who will gain control of the
guadrant. | get to ask the contestants fifteen
guestions, starting with the easiest question,
which will win you that crappy abandoned
space station, Empok Nor, and progressing up
to the most difficult question, which earns you
the entire Alpha Quadrant! Now, you have to
get all the questions right or else you walk
away with nothing and end up a POW of the
winner! Doesn't that sound like super-duper
fun?!

DUKAT: Can we get on with this?

BONNY: Sure! I'm as eager as you are to see
who will win this battle of wits! Now, you have
three life-lines to help you out. First is the 25:75,
where we take away one of the wrong
answers -

DAMAR: Wait a minute. | thought it was the
50:50!

BONNY: Well, it was, but gee, we can't do
everything for you people, can we? Anyway,
the second life-line is the Phone An Ally, and
then there's the Ask An Impartial Observer.
And now, playing for the Cardassian Union,



we have everyone's favorite Cardassian trio,
Damar, Dukat, and Garak!

DUKAT: {glaring at BONNY} We are not a trio.

BONNY: {grin falters a bit, but stays in place}
Really? Uh, well, | just thought, since there are
three of you . .. Um, you are all playing for a
liberated and autonomous Cardassia, aren't
you?

GARAK: Technically, I'm still an exile.

DUKAT: | was the one who signed a contract
with the Dominion in the first place.

DAMAR: Well, I'm a rebel fighting for the
freedom of Cardassia, anyway.

BONNY: {claps his hands} Well, okey-dokey
then! | guess you were the only three
Cardassians we could find for the show.

DUKAT: Yes, that would explain why I'm sitting
here with two traitors, wouldn't it?

BONNY: {not grinning so big now} Um, is there
gonna be a problem here? {perks up again}
C'mon, guys, we're all just one big happy
family, right?

DUKAT: No.
GARAK: Not really.
DAMAR: Unh-uh.

BONNY: {pretends he didn't hear them} Well,
all righty then! Let's play Who Wants to Rule
the Alpha Quadrant! For the space station
Empok Nor, here's your first question:

In the Federation, who developed the Picard
Maneuver?

A) Captain Kirk B) Captain Picard C) a tribble
D) me, Bonny Ozmont!

DAMAR: {to DUKAT and GARAK} Why are they
giving us a Federation question? {to BONNY} Is
the entire game rigged like this?

GARAK: {rolls his eyes} The answer is Picard.
BONNY: Is that your final answer?
GARAK: Of course.

DUKAT: Hold on. Let's not be hasty about this. It
could be a Federation trick.

BONNY: {looking back and forth between
them} | need the whole team to agree before
| can lock it in as your final answer.

{the three Cardassians argue amongst
themselves for a few minutes before settling
back into the chairs. DUKAT and GARAK are
glaring at each other, but DAMAR, at least,
seems satisfied.}

DAMAR: Picard is our final answer.

BONNY: Okay. And . .. You're right, for Empok
Nor! Here's your second question. If you get
this right, you win an obscure, useless moon in
the Vulcan system!

In the popular Brithey Speatrs song, "Oops | Did
It Again" what line of the song immediately
follows the title line?

A) | played with your heart B) | blew up your
planet C) | ran over your puppy D) | allowed
myself to become possessed by a Pah-wraith
DAMAR: {confused} What's a Brithey Spears?
GARAK: Believe me, you don't want to know.
DUKAT: {frowning} Is D supposed to be aimed
at me? If so, | must say I'm a bit disappointed
in the writers. | expected better insults from
them. Anyway, the answer is A.

DAMAR: {surprised} How do you know?
DUKAT: | know.

DAMAR: Yeah, but how?

DUKAT: {annoyed} Never mind how! Final
answer!



BONNY: That okay with you guys? {looks at
DAMAR and GARAK, who shrug and nod} And
... Congratulations! You got it right! {to
DUKAT} Isn't Britney Spears the greatest? {no
response but an evil glare} Okay, on to
guestion three, then! This is for the main Vorta
cloning facility -

WEYOUN: {speaking up from the darkened
contestant area} Excuse me for interrupting,
but why is the cloning facility only the third
guestion? That would lead one to believe that
it's not an important addition to anyone's
conqguest.

DUKAT: It's not.
DAMAR: Nobody likes you, Weyoun.

GARAK: Ah. Finally something we can all
agree on.

BONNY: {waves his arms and points to himself}
Excuse me? Hi, hello, host here, remember?
Here's your third question.

How many illegitimate children does Dukat
have?

DUKAT: {exasperated} Oh, | really must protest
this question. This is absolutely ridiculous.

GARAK: Afraid you can't count that high?
BONNY: {rushing in before DUKAT can
respond} A) 0 B) 10 C) 147,000 D) answer hazy,
try again later

GARAK: Well, we all know it's not A.

{DAMAR and GARAK both look at DUKAT, who
sighs and begins counting on his fingers.}

GARAK: This could take a while.

DAMAR: {to DUKAT} Do you want to use the
Phone an Ally life-line?

DUKAT: {waves him off} Shh! I'm thinking.

{continues counting his fingers at an alarming
rate}
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A LONG TIME LATER . . .

DUKAT: {muttering} . . . and then there was the
one on Risa . .. what was her name? . .. two
Orion slave girls, but those babies looked
nothing like me . ..

A LONG, LONG TIME LATER . . .

DUKAT: {still muttering} . . . and that was just in
the last ten years . . . let's see, before that
there was . . .

A LONG, LONG, LONG TIME LATER . . .

DUKAT: {still muttering} . . . and when | was in
school . . . she never proved it, though . . .
{finally looks up and notices everyone staring
at him in astonishment} What? I'm not the only
man to ever have had a few indiscretions, you
know.

KIRA: {from somewhere in the audience;
incredulously} A few? A few?! You call that a
few?! You've been droning on for three hours!

BONNY: {has lost his manic grin, in fact, he
looks a bit stunned and is almost speechless}
Wow. You certainly are, um . . . virile . . . aren't
you.

ANONYMOUS WOMAN IN THE AUDIENCE:
{stands and holds up a baby} Whatever
number you came up with, Dukat, you better
add one more to it!

DUKAT: {squints into the audience} Do | know
you?

DAMAR: {elbows DUKAT} What number did
you get? We need to answer the question.

DUKAT: | think I'm going to have to say D,
answer hazy, ask again later.

GARAK: {disgusted} Does that mean the
actual number is more, or less, than 147,000?

BONNY: {recovering his grin} Whatever else it
means, you are now the proud owners of the
Vorta cloning facility! D was the right answer!
Good for you! Now, your fourth question will



get you some worthless planet | can't
pronounce. Here we go!

If a tree falls in the woods and nobody is there
to hear it, did it make a sound?

A) Yes B) No C) The sound of one hand
clapping D) Only if it fell on Weyoun

DAMAR: | hate philosophy.

GARAK: {annoyed} It's a badly phrased
guestion. If a tree falls in the woods and
nobody hears it, does it make a sound? Are

we referring to the tree or the woods? What is
'it'? It's an unclear question.

DUKAT: I'd say D, only if it fell on Weyoun.
DAMAR: Me too.
BONNY: Is that your final -

GARAK: No! If it fell on Weyoun, then there
was somebody there to hear it.

DAMAR: {snickering} | bet Weyoun would
make a sound if a tree fell on him.

DUKAT: Fine, that eliminates D. That leaves A.
Yes, the tree made a sound.

GARAK: How do you know? You didn't heatr it.

DAMAR: Okay, then, B. No, it didn't make a
sound.

GARAK: How do you know? You didn't not
hear it.

DUKAT: {irritated} Well either it did or it didn't.
Make up your mind.

GARAK: Nobody can say with any certainty. It
must be C.

DAMAR: {confused} The sound of one hand
clapping? What's that got to do with
anything?

GARAK: Philosophy.
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DAMAR: | hate philosophy.
DUKAT: {dryly} You mentioned that.

DAMAR: {shrugs} Okay. Let's go with C. | don't
get it, but | guess it's our final answer.

BONNY: . ... Yes! You got it! And | always
thought this was the sound of one hand
clapping. {holds one hand out and opens and
closes it really fast, producing a clapping
sound. Everyone stares at him like he's an
idiot.} Hey, wanna hear the most annoying
sound in the world?

DUKAT: Not particularly.

BONNY: Party-pooper. Fine then, here's your
fifth question. This is a big one. If you get this
right, you win this station, Deep Space 9!

DUKAT: You mean Terok Nor.

BONNY: {looks like he's about to cry} I don't
know, okay? I'm just reading what's coming up
on my screen! {sniffles} Anyway, here's the
stupid question. {suddenly turns and yells at
the audience} Would you people please stop
shooting at me! You're really hurting my
feelings! Hey! What was that? Did someone
just throw a beer at me?

QUARK: {to audience member who threw the
beer} | hope you know I'm still charging you for
that, buddy!

BONNY: {sniffles again} Okay. Here it is.

What material is made by worms?

A) Leather B) Burlap C) Silk D) Spandex
{DAMAR and DUKAT both look at GARAK.}
DUKAT: Well, tailor?

GARAK: {sighs} Does that mean you don't
know the answer? {before DUKAT can answer}

C. That's our final answer.

BONNY: {pouting} Well, duh. I'm gonna warn
you, even though you don't deserve the



warning, the questions will start getting harder
now. If you get this one right, you win the
wormhole.

In the 1971 movie, "Dirty Harry", what
astrological sign was the killer known by?

A) The Virgo Killer B) The Cancer Killer C) The
Scorpio Killer D) Hellraiser

{this time, everyone in the bar looks at GARAK}

GARAK: {exasperated} Why do you
automatically assume | know?

DAMAR: | got the feeling this is one you would
know.

DUKAT: Are you saying you don't?

GARAK: | never said that. | simply meant it's
time for the two of you to start pulling your
own weight, as it were.

BONNY: {apparently over his temper-tantrum}
You can still use a life-line. You have all three

left!

GARAK: That won't be necessary. | didn't say |
don't know it.

DUKAT: Then answer the question.

DAMAR: Hey, wait a minute. Hellraiser isn't an
astrological sign!

DUKAT: {dryly} Very astute, Damar.

GARAK: {to himself} This seems familiar
somehow . . .

BONNY: Well, if you don't want to use a life-
line, you could always take a guess. {in a fairly
decent Dirty Harry imitation} | guess what you
gotta ask yourself is, Do | feel lucky. Well, do
ya...punk?

GARAK: {jumps} What?! Scorpio! It's Scorpio!

DUKAT: How do you know?
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GARAK: {shakes his head}I'm ... I'm notsure ..

BONNY: Final answer? {GARAK nods} Yup,
you're right! Isn't "Dirty Harry" just the coolest
movie ever?

GARAK: | .. .wouldn't know . ..
DAMAR: What's wrong with you?

BONNY: {still gushing over the movie} | mean,
who could forget the Scorpio killer? He was
definitely memorable!

GARAK: {smiles} I'm glad you think so.
DUKAT: {annoyed} Did we miss something?

BONNY: Okay! This next question will win you
the entire Bajoran system! Wow, a whole
system! Goody-goody gumdrops!

DAMAR: {in disbelief} Did he really just say
goody-goody gum -

DUKAT: {slaps a hand over DAMAR's mouth}
Please, | don't need to hear it again.

BONNY: If train A leaves New York traveling 60
miles per hour, and the skies are partly cloudy
with a chance of rain in Texas on Friday, with a
variable of pi, what is the meaning of life?

A) Spoons B) Tribbles C) Three D) Where's
Waldo?

{DAMAR, DUKAT, and GARAK stare at the
guestion, then at each other, then at BONNY,
then at each other again. Finally GARAK
manages to speak.}

GARAK: {cautiously} It seems you may have a
computer virus. Might | suggest a level five
diagnostic?

BONNY: Nope, that's the real question! You still
have all your life-lines if you need some help!

DUKAT: No, I'm sure we can figure this out on
our own.



DAMAR: I'm not.

GARAK: The meaning of life is certainly not
spoons.

DAMAR: | don't know. Spoons are pretty
important.

DUKAT: It can't possibly be tribbles.

DAMAR: | don't know. Tribbles are kind of cute.
DUKAT: | hate tribbles.

GARAK: That leaves three and Where's Waldo.
DUKAT: Three seems the least stupid answer.
DAMAR: {confidently} Three. Final answer.
DUKAT: Now, just a minute -

BONNY: That's right!

DUKAT: {claps DAMAR on the back} Good
work, Damar!

BONNY: Okey-dokey! Next question! If you get
this one right, you win back Cardassia from
the Dominion! Here we go!

Why did the chicken cross the road?

A) Because it was stapled to Weyoun B) To get
to the other side C) Jellybeans D) | like shrubs!

DAMAR: Are they serious? Do they think we're
idiots? To get to the other side, of course.

DUKAT: Agreed.

GARAK: Wait. That's too easy. It's just what
they want us to think.

DAMAR: Maybe we should use a life-line.

DUKAT: {attempting to be patient} Damatr, it's
a ridiculously easy question. | am not going to
waste our life-lines on "Why did the chicken
cross the road"!
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GARAK: The chicken didn't cross the road
arbitrarily. I'm sure the chicken had an ulterior
motive. "To get to the other side" seems a bit
suspicious to me.

DUKAT: {rapidly losing patience} While I'm sure
you're well familiar with the logic of poultry,
Garak, I'm still not wasting a life-line on such a
stupid question!

DAMAR: Bonny, let's go ahead and use the
25:75.

DUKAT: No!

BONNY: Oooh, too late. The computer has just
taken away one of the wrong answers.
Whatta ya think now?

{the Cardassians look at the screen in front of
them. The computer has taken away B) To get
to the other side.}

DUKAT: | don't believe it.

GARAK: {smug} | told you it was too easy.

DAMAR: What now? All that's left are stupid
answers.

DUKAT: We've made it this far with stupid
answers.

GARAK: It's not A.

DAMAR: Why not?

GARAK: Because it was stapled to Weyoun?
So what? There's no allusion to Weyoun

crossing the road.

DUKAT: But that only leaves "Jellybeans" and '
like shrubs". What kind of moronic game is this?

DAMAR: Maybe it's "Jellybeans". Do chickens
like jellybeans?

DUKAT: {muttering} I'm surrounded by idiots.

DAMAR: Should we use another life-line?



GARAK: {dryly} Of course. Perhaps there's a
chicken in the audience who would know the
answer.

{at that moment, a chicken jumps onto a
barstool and begins pecking at QUARK}

GARAK: What a fortuitous arrival.

DAMAR: {stares at GARAK, then at the
chicken, then back at GARAK} Wow.

DUKAT: This is ridiculous. {sighs} All right, let's use
the Ask An Impartial Observer and see what
the chicken has to say for itself.

BONNY: Okay! {turns to the chicken} Well, you
heard the question. Why did the chicken cross
the road? What do you say?

CHICKEN: Buck-buck! Buck-buck!

DUKAT: Infernal chicken! That's not an answer!

CHICKEN: Buck-buck! Buck-

{suddenly a bat'leth flies through the air,
chopping the chicken's head off. The chicken
continues to hop around for a minute before it
realizes it's dead and falls over. A group of
Klingons cheer and toast each other loudly.}

GARAK: {frowns at the dead chicken} Pity. If
I'd had five minutes alone with the chicken,
I'm sure | could have extracted the
information we needed.

DAMAR: We could still Phone an Ally.

DUKAT: But who? Do you know anyone who is
familiar with chickens?

DAMAR: No. Do you?
DUKAT: No.
GARAK: | might know someone.

DUKAT: Who?
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GARAK: I'm afraid | can't divulge that
information. {reaches for the nearest comm
panel} May I?

BONNY: Sure!
GARAK: Thank you.

MYSTERY VOICE FROM THE COMM PANEL:
Hello?

BONNY: Hiya! This is Bonny Ozmont from Who
Wants To Rule The Alpha Quadrant! I've got
Garak here, and he's stuck on a question! The
next sound you hear is gonna be his voice,
okay?

GARAK: Why did the chicken cross the road?
MYSTERY VOICE: Is this a joke?

GARAK: Sadly, no. We've got it narrowed
down to either "jellybeans" or "| like shrubs".

MYSTERY VOICE: Oh! Well, in that case, the
answer is -

{another bat'leth flies through the air,
smashing the comm panel before the mystery
voice can reveal the correct answer.}

DUKAT: How are we supposed to play the
game when the Klingons are bent on
sabotage?!

DAMAR: {staring at the answers left on the

screen} | think "jellybeans" makes more sense
than "l like shrubs".

BONNY: You wanna make that your final
answer?

DUKAT: We might as well.

GARAK: None of these answers have made
any sense. Why should this one?

DAMAR: You think it's "l like shrubs"?
GARAK: | don't particularly care. I'm going

back to my shop. I've got some sewing to
finish. {gets up to leave and is stopped by a



group of producers wielding a variety of very
mean-looking weapons} On second thought,
perhaps | will stay.

BONNY: I'm gonna need an answer, guys.
DUKAT: Fine. We'll take "Jellybeans".

BONNY: {after a long pause} No! I'm sorry. {not
sounding particularly sorry} The answer we
were looking for was "l like shrubs!”

GARAK: | knew it.

DUKAT: What? That doesn't make any sense!
Why did the chicken cross the road? | like
shrubs! What does one have to do with the
other? | demand a full investigation into this!

DAMAR: {giggles} | like shrubs! That's funny!
DUKAT: {gritting his teeth} Shut up, Damar.

{the Cardassians are led out of the bar by the
heavily-armed producers, DUKAT protesting
loudly, DAMAR still giggling over the shrubs,
and GARAK shaking his head and telling the
others that he told them so.}

BONNY: {to the camera} Well, that's too bad,
isn't it? We're going to take a short
commercial break, and when we come back,
we'll have a group playing on behalf of the
Ferengi Alliance! Don't go away!

{segue into a looooooooong commercial
break. When the show finally does come
back, the three contestant chairs are filled by
ROM, BRUNT, and GRAND NAGUS ZEK. The
floor around BONNY's chair is a mess of
weapons, thrown food and drinks, and it also
appears as if someone has lobbed a few
tomatoes in his direction, too.}

BONNY: Hiya! Welcome back! We're here now
with -

DRUNK KLINGON IN THE AUDIENCE: We don't
care who they are! Get on with it, P'tak!

BONNY: Okay, | don't know what that word
means, but it didn't sound very nice! Shame

on you! If you want me to speed things along,
all you have to do is ask nicely!

{in response, the DRUNK KLINGON hurls a
bat'leth at him.}

ROM: Uh, for a Klingon, that was asking nicely.

BONNY: Yikes. | can't wait til it's time for the
Klingons to play. {sticks his tongue out at the
DRUNK KLINGON} I'm behind this force-field
and you can't get me! Nah-nah-nah-nah-nah!
{turns back to the Ferengi contestants} Okay,
let's play!

{suddenly, somebody walks through the
crowd and right through the force-field. As this
person grabs BONNY by the throat and tosses
him across the bar, we see that the new
arrival is actually REESES KILLBEN, but with Borg
implants! He takes his seat in the host's chair
and turns to the three Ferengi, who all look a
bit stunned.}

REESES-BORG: Bonny Ozmont is irrelevant. | am
your host. Now let's play. The life-lines are
irelevant. If you do not answer right away,
you will be assimilated.

ZEK: Inconceivabile!

REESES-BORG: Conception is irrelevant.

BRUNT: What do we get if we do answer right
away?

REESES-BORG: You get to live.

BRUNT: What a rip-off.

REESES-BORG: Your first fourteen questions are
irrelevant. You will only get one chance to

answer the last question.

ROM: {uncertainly} Uh, can you do that? {to
the producers} Can he do that?

REESES-BORG: Your questions are irrelevant.
Only Reeses-Borg's wishes are relevant.



ZEK: Wait a minute! | was told there would be
the opportunity for profit! Where's the profit? |
don't see any latinum, or -

REESES-BORG: Profit is irrelevant.

ZEK: {stares at him like he's insane} What?
Stupid host! Profit is never irrelevant!

ROM: Uh, Nagus. ..

REESES-BORG: You are irrelevant. You will
answer this question or be assimilated.

What do | have in my pocket?
{silence}

ROM: {hesitantly} Um, isn't this supposed to be
multiple-choice?

REESES-BORG: Choice is -
BRUNT: Let me guess - irrelevant?
REESES-BORG: What do | have in my pocket?

BRUNT: Preciousssssssss, what does it have in its
pocketsessssssss?

ROM: {concerned} Uh, are you all right?

BRUNT: {clears his throat} Yeah. Fine. Why do
you ask?

ROM: No reason.
REESES-BORG: You will be assimilated.

BRUNT: Hey, you have to give us a chance to
answer the question!

ROM: Uh, maybe we should use a life-line?
ZEK: What good would that do?

ROM: Well . . . {pulls ZEK and BRUNT in close
and begins whispering.}

ZEK: Perfect! {turns to REESES-BORG} Hey, you!
We'll take the Ask An Impartial Observer life-
line.
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REESES-BORG: The impartial observer is
irelevant.

ZEK: You keep using that word. | don't think it
means what you think it means. {gloating}
Hah! Do you know how long I've wanted to
say that?

REESES-BORG: Irrelevance is irrelevant. Choose
your observer.

ROM: Okay, then, uh ... we choose you.

REESES-BORG: {looks at the producers} But . . .
Reeses-Borg is host. Reeses-Borg cannot be an
impartial observer if Reeses-Borg is host.
Inconceivable.

ZEK: Irrelevant!

PRODUCER #1: Technically, Reeses-Borg isn't
under contract. His hosting is unofficial, so he
can, in fact, act as an impaurtial observer if
need be.

REESES-BORG: But . . . Reeses-Borg is host!

ZEK: Answer the question! What does
Reesesssssss-Borg have in its pocketsessssssss?

ROM: Oh, no, not you, too!

REESES-BORG: I...I...{hangs his head}
Reeses-Borg has a bagel in his pocket.

ZEK: Hah! A bagel! Final answer!

REESES-BORG: The Alpha Quadrant is
irrelevant. It is yours, but it is irrelevant. Reeses-
Borg must go back to Earth. Smelly Ripa will be
assimilated. {wanders out of the bar, muttering
in very un-Borg-like fashion about all the
people who need to be assimilated.}

ROM: {disbelievingly} We won?
BRUNT: {stunned} That's it?

ZEK: I'm the ruler of the Alpha Quadrant! Hah!
Fools!



PRODUCER #1: Uh, actually, you're not.

ZEK: What do you mean? Of course | am! |
won!

PRODUCER #1: Uh, no, not really. See, since
Reeses-Borg wasn't the official host, he has no
authority to ask the questions or give away
any prizes. Sorry, but the game is going to
have to continue until we find a legitimate
winner. I'm afraid you need to clear the stage
now.

ROM, BRUNT, & ZEK: Inconceivable!

~The end . .. orisit?~
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USF Cookbook

By Ret. Fleet Captain Robb Clemens

Years ago, an attempt
was made by me to
gather those recipes that
our fellow members of
the USF wanted to

share. Unfortunately, a
lot of the data that was
sent was lost when my
computer took a turn

S
south. However, | was

able to recover a few of

the recipe’s... not that there are very many.

&

So here we are once again trying to make this
reality once again come true. If you'd like to
submit a recipe for the next edition of the PADD
please forward your recipe(s) to
USFPADD@gmail.com.

This recipe was submitted by Retired Fleet
Captain Roel Jere. Buon Appetito!

Hasperat

Ingredients:

Flour Tortillas
Cream Cheese

1 Red Pepper

1 Green Pepper
Comments:

This little recipe is a staple of every Bajoran’s diet.

It’s spicy yet at the same time very soothing, a lot like most
Bajoran women. It makes a great lunch, or an excellent
midnight snack for those graveyard shifts on the bridge. |
like to spice mine up by adding hot sauce (Tabasco sauce,
taco sauce, or even wasabi if it’s handy) but then again, |
spice up everything, even my fruit salads.

Directions:

Wash and slice (lengthways) the red and green
peppers, and get rid of the seeds. Then, spread cream cheese
over as many tortillas as you have room for peppers. (If
you’re using big tortillas and little peppers, this might be only
one tortilla — big peppers and little tortillas, you might be able
to make three or four.) Spread the cream cheese as thick or
thin as you want, and then press the pepper slices on. Roll
and enjoy.

Sounds nova hot... with anything spicy, you have
to have something sweet to balance it out.
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Here is a recipe from Vice Admiral Ahrele
Johannson Oliver on her Gooey Butter Cake. And
from what | hear it’s a favorite. Buen Provechol!

Gooey Butter Cake

e 113 x9cake pan
e 1(18.25-ounce) box yellow cake mix

1 egg

1/2 cup (1 stick) butter, melted
e Filling
¢ 1 (8-ounce) package cream cheese, softened
e 2eggs

e 1 teaspoon pure vanilla extract
e 1 (16-ounce) box confectioners' sugar
e 1/2 cup (1 stick) butter, melted

1. Preheat oven to 350 degrees. Lightly grease a
13x9x2-inch baking pan.

2. Inthe bowl of an electric mixer, combine cake mix,
egg, and butter and mix well. Pat into the bottom of
prepared pan and set aside.

3.  Still using an electric mixer, beat cream cheese
until smooth; add eggs and vanilla. Dump in
confectioners' sugar and beat well. Reduce speed of
mixer and slowly pour in butter. Mix well.

4. Pour filling onto cake mixture and spread evenly.
Bake for 40 to 50 minutes. Don't be afraid to make a
judgment call on the cooking time, because oven
temperatures can vary. You want the center to be a little
gooey, so don't bake it past that point!

5.  Remove from oven and allow to cool completely.
Cut into squares. Just remember that these wonderful
little cakes are very, very rich, and a little will go a long
way-even for me!

Pumpkin Gooey: This variation has to be at the top of
my list, especially around Thanksgiving. For the cake
part, | sometimes use a spice cake mix. | have even
used a chocolate cake mix, but | think my favorite is the
basic yellow cake mix. Follow the original recipe, adding
a 15-ounce can of pumpkin pie filling and an extra egg
to the cream cheese filling. Bake as usual, remove from
oven, and allow to cool. Cut into squares and top each
square with a pecan half. Serve with a dollop of fresh
whipped cream. | promise you'll never want pumpkin pie
again!
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USF Photoshop Tuforials

Part | - Intfroduction ond Boasics
by Lt. Cmdr. Havraha cha’ AAnikh

If ’'m known for any one thing in the USF, it’s the simple fact that | freely and happily create bio
images for simmers. However, as someone who always promotes individual empowerment, I’ve
opted to begin a tutorial series for the PADD. What does this tutorial series do? Well, it will teach
you from the very basics everything you need to know to start editing your own bio images. This first
entry will cover two subjects — what you need, and how to use it.

What You Need

Photo manipulation is often called “photoshopping” for a reason — the current leader in photo-
manip software is the program Adobe Photoshop, available for both Windows and Macintosh
computers. However, Photoshop is a very pricey program. Now you may wonder how on earth
you’re going to follow along with this tutorial. Do not fret my apprentice! If you don’t have $600 to
drop on a piece of computer software, you have a couple of options available to you.

The first option is to purchase Adobe Photoshop Elements, a simplified version of the program aimed
at non-professionals which costs significantly less than the full featured version. It works, but it’s so
drastically different from the typical Photoshop (and by that, | mean it’s FAR more simplified), that
using it for this tutorial may be pretty useless. Second, you can purchase one of Photoshop’s
competitor programs, the Windows exclusive and very capable Corel Paint Shop Pro. However,
Paint Shop Pro isn’t exactly the same as Photoshop, and it won’t be covered in this tutorial, so if you
can’t be flexible with discovering the program yourself, that may not be the right course for you
either. Beyond that your other option would be to download Photoshop from a person-to-person
(or P2P) file sharing program like Bittorent and

websites that host such content. However, this is Note: Linux users can search for the project
highly unadvisable, considering i_t’s complicated, that successfully ported Photoshop CS2 to that
unsafe for your computer from viruses, and platform. The beta form was released in
ultimately downright illegal. Are none of these January of 2008.

sounding appealing? Don’t worry, you can always
download a free trial of Photoshop CS3 straight
from Adobe’s website, or you can look online and purchase a copy of an older version of
Photoshop, such as Photoshop CS2, CS, or even Photoshop 7. The reason this is possible is because
Photoshop’s core tenants have remained nearly identical over the years, with the latest version only
offering slight improvements over the last.

If you can acquire Photoshop one way or another, you can begin to make use of the tutorials seen
here in the PADD.

How to Use It — Finding Hidden Tools

So you have your copy of Photoshop yet? If you do, you can read on right from this point and start
learning the very first bits of tips that will give you a head start in understanding and using advance
photo manipulation software. For this tutorial, | will be using my copy of Adobe Photoshop CS3
Extended, which may look significantly different from yours, but fear not! | ought to be thorough
enough to make sure you find what you need.
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At some point in time, you’ve probably played around with Microsoft Paint. In case you’ve
forgotten what that looks like, here you go —
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This is a screenshot of MS Paint from Windows Vista. Sorry for the small size, it’s because | have such
a high resolution monitor. If you can squint your eyes hard enough, you’ll notice all the tools to the

left side of the screen. This feature is carried over in Photoshop, but with one difference - there’s a
LOT of them.
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This is Photoshop CS3 on my computer, and do you notice the long list of tools on the left side? Let’s
get a closer ook --



The Toolbar, when looked at closely, has an array of tools. There’s so many tools, you
may be intimidated at first, but don’t worry — we’ll get into what each tool is and what
they do one at a time in the following tutorials. The likelihood is, you’ll find out what some
tools are and how to use them far faster than I’ll be able to tell you in between PADDs.

i
+E

But the point of showing this to you is to get you to see that many of the icons have small
arrows in the corner. These arrows indicate that there’s even more tools hidden below
them. To access these tools, left-click and hold down on a tool to bring up a “drop down
menu” of more. Many of the tools stacked in this way have something in common - the
dodge tool may be below the burn tool just because they produce the exact opposite
effects of one another. All the healing tools will be stacked upon each other - it’s very
well organized intuitively, so as you use Photoshop, you’ll begin to make the connection
and instinctively know where some tools are, despite the fact you can’t see them
immediately. The point to this is that it saves you much desired real-estate on your
monitor for more important things, like your bio image you’re going to make.
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You’ll notice to the right here, I’'ve left clicked
and held down on the paint brush to reveal 55_; I
even more tools. While the paintbrush makes .

AN NS

a large smooth line, the pencil tool will make @ m _# Brush Tool B
a very jagged line more along the lines of )

what you’re familiar with from MS Paint, and %, .x;rl e B
the Color Replacement Tool is specifically = l}V Color Replacement Tool B
designed to replace the color of what you 4

paint over with whatever color you have |

[ 8

selected, without destroying the light and dark places. You’ll notice that beside each
tool is the letter “B”. This is the hotkey for this tool — by pressing B on the keyboard, you
can automatically select the brush tool without even clicking on it, and you can scroll
through each subsequent tool in the drop down menu by pressing B again. The more
hotkeys you learn in Photoshop, the faster your workflow will go.
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How to Use it — Understanding the Concept of Layers

b

The biggest difference between MS Paint and Photoshop is something called Layers.
Layers are exactly what they sound like — they’re literal layers on the image you’re
working with. This may be confusing to some, but it’s easiest to understand with a
demonstration. So let me do so.

b

b

| Layers % | Channels | Paths | __,;
To my right, you will see what’s called the Layers Panel (or Normal ~ Opacty:| 100% | *
Palette, if you’re using an older version of Photoshop), and Lock: (3 & & @ Fill:| 100% | »
within it, all the layers are organized and controlled. You can :
see | have two layers open, and Layer 2 is above Layer 1. You b Z_
can also note that Layer 2 is selected. Your layers panel may
have only one layer on it, if you’ve made a new image to
follow along. To make a second layer, click the small icon you
see circled here - this is the new layer icon. Hover over any
icon to see what it means. Don’t have a Layers Panel or
Palette? Go to “Window > Layers” at the top menu to turn it

on. Let’s move on down to the next page to show you what |
can do with this. = &. O °.

b

2
&
v
T
R
L]
4

e
&5

(.
&

k) Layer 1

G o gl

[ 9

32



T Untitled-2 @ 100% (Lay... [= |[ & |53

. . . - X

" | panel, you’ll see that the blue | Layers x | Channels | Paths | =
% G|« i cross is actually on Layer 2, while | mermal ~ Opacity:| 100% | *
the red square is on Layer 1. | did this by first clicking on Layer 1 to Lock: [ & & @ Fill:| 100% | »

select it, and then painting my red square. Then, | clicked on layer 2
and drew the blue cross. You can do this in any order, on any layer,
and click and drag them on top or below one another. Remember, ® @

. . Layer 1
the layer on top in the layers panel, appears above the image drawn

on the layer below it.

So what does this do beyond making sure my lines are straight? Well
... look. If | select Layer 2, then pick my eraser tool and swipe across

T Untitled-2 @ 100% (Lay... [ = |[ &[]

100% (@] < b

Here, you see my drawing | have. | have a blue cross on top
of ared square. The gray and white checkers you see are
the default way for Photoshop to indicate that this space is
actually transparent. That comes in handy when you’re
making images for the web that will have transparent parts to
more seamlessly blend in with the rest of the webpage. But
that’s not the focus of this example. The example is for you to
see HOW I’ve used the layers to set this image up.

Here, on this view of the layers

— x
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the entire image... p
... the only thing that erases is = P ® 0O & 9 .
the blue cross, which was drawn ——
on layer 2, even though my eraser clearly goes over several
portions of the red square that was drawn on Layer 1. You
can see how this very specific method of “constructing” an
image using layers is leaps and bounds above anything that
was possible using MS Paint - it allows you to essentially add
to and erase on images without being destructive to other
parts of it, and it’s the hidden secret to how Photoshop gurus
make their magic reality. Master the layers, and you’ll master
the image.

How to Use it — Copy and Paste

The last thing I’ll introduce you to in this first tutorial is how to copy and paste an image. If you have
a picture from the internet that you want to manipulate, but you don’t want to bother saving it to
your hard drive, you can right-click it, copy it, and paste it into Photoshop just as you would in MS
Paint. The problem, however, is that you cannot simply go to Edit > Paste at the top of the program
menu like you would normally do in Paint. If you try, it will just be grayed out. So, how do you copy

and paste images in Photoshop?
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The simple trick is to go to
“File > New” instead. What?
That was it? Yes, that was it.
It’s that simple. Photoshop
requires an image to already
be open to copy and paste
another image into it.
Although you’ll see a rather
complex looking dialogue
box wanting to know the
specific size of the image you
want to open, you’ll notice
that it already has
measurements filled in if
you’ve copied the image first
- they’re the exact
measurements of the image
you’ve copied to your
clipboard (the clipboard is
that invisible place where
everything you right click and
copy goes before you paste
it). So what do you do
again? You go to “File >
New”, select okay on
whatever measurements it
presents you with, and THEN
go to “Edit > Paste” to paste

the image you’ve copied in Photoghop. Photoshop will automatically make the new pasted image
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T Untitled-10 @ 100% (Layer 1, RGB/8)

Born to be wild baby!

100% (8 Doc: 571.0K/571.0K
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a new layer on top of the original image, which should be called “Background” in your Layers

Panel. From there, you can add layers, draw on it, cut it up, do whatever. Have fun! Experiment!
This is the time for you to do so, as the following tutorials will actually start teaching you about tools,
effects, and techniques required to begin making your own bio image.

Congratulations, if you learn the few things mentioned in this first tutorial, you’re already way ahead

of the curve of amateur users wanting to learn Photoshop! Hang in there! The best stuff is yet to

come!
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